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Unit 4: Slides
Lesson 4.1 Easy Eats for Teens

Formatting Text and Images
Create a New Presentation • Choose a Theme • Select Text • Format Text • Add a New Slide • 
Horizontally Align Text • Insert an Image • Resize an Image • Crop an Image • Change Slide Layout 
• Create a Bulleted List • Change Line Spacing • Delete a Text Box • Preview a Presentation • Exit a 
Presentation • Share a Presentation • Close a Presentation

Lesson 4.2 Fun With Apps
Using Shapes

Insert Shapes • Align Shapes • Change Fill Color • Change Line Color • Change Line Weight • 
Duplicate a Slide • Use Undo/Redo • Insert Word Art • Insert a Text Box • Group Objects • Use Zoom

Lesson 4.3 Traveling to Hawaii 
Working with Images

Use an Image as a Background • Use Color as a Background • Create a Numbered List • Use Image 
Options • Mask an Image • Reset an Image • Insert a Link • Vertically Align Text • Insert a Video • 
Apply Transitions • Delete a Slide • Automatically Advance Slides

Lesson 4.4 Safe Cars for Teens
Collaborating with Slides

Collaborate • Insert a Table • Copy and Paste • Insert an Animation

Unit 4 Assessment 
Performance Assessment is located on the Instructor’s Resource CD.



98 Learn-by-Doing: Google Docs

1. Sign into Google Drive. 

2. Create a New Presentation. To create a new presentation, open your My Slides folder, click the NEW 
button and select Google Slides.  

Easy Eats for Teens
Formatting Text and Images

You have joined the Health & Fitness Club at school. To promote 
healthy eating, you decide to create a presentation on the club’s web 
site. The presentation will offer healthy food options for breakfast, 
lunch, snack, and dinner. 

Overview

New Skills

Instructions

Create a New Presentation • Choose a Theme • Select Text • Format 
Text • Add a New Slide • Horizontally Align Text • Insert an Image • 
Resize an Image • Crop an Image • Change Slide Layout • Create a 
Bulleted List • Change Line Spacing • Delete a Text Box • Preview a 
Presentation • Exit a Presentation • Share a Presentation • Close a 
Presentation

In this lesson, you will 
create a presentation 
about healthy eating 
habits using bulleted 
lists.

Lesson 4.1
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Lesson 4.1Formatting Text and Images

3. Choose a Theme. To coordinate colors, background, fonts, and effects in your presentation, from the 
Choose a theme dialog box, select Light Gradient and click OK.

4. Rename your presentation Lesson 4.1.

5. Select Text. In this lesson, you’ll be required to select text. There are several ways to select text in your 
presentation: 

a. Position your cursor at the beginning of the word, left click the mouse, and drag to the right to the 
end point of the text you want to select.

b. To select a single word, double-click on the word.

c. To select an entire paragraph, triple-click within the paragraph or position your cursor at the 
beginning of the paragraph and hold down the Shift key while pressing the Down arrow key.

d. To select all of the text in a text box, click anywhere in the text box, hold down the Ctrl key, then 
hit the A key. 

SLIDE 1:

6. Type the title and subtitle as shown in 4.1 Figure A.

7. Format Text. Make the following formatting changes: 

a. Select the text in the title box and change the Font to Cambria. 
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Formatting Text and ImagesLesson 4.1

b. Select the text in the subtitle box, change the font to Cambria and Italicize. 

8. Add a New Slide. To insert additional slides into your presentation, from the New slide drop-down 
menu, select Title and Body.

SLIDE 2:

9. Type the title and body text as shown in 4.1 Figure A.

10. Change the font size of the body text box to 28.

11. Horizontally Align Text. To horizontally center align the body text, select the text, then from the 
Align drop-down menu, select Center.

12. Click at the end of the last line of text and hit Enter.
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13. Insert an Image. To insert an image of healthy food below the paragraph, do the following:

a. From the Insert menu, select Image.

b. Click Search, type [healthy food] in the Google search field, then hit Enter.

c. Double-click an image of your choice.

14. Resize an Image. To change the size of an image proportionately (larger or smaller), do the following:

a. Click the image, then click and drag the bottom-right resizing handle.

b. Resize and position the image so it looks similar to Slide 2 in 4.1 Figure A.
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Formatting Text and ImagesLesson 4.1

15. Crop an Image. To change the proportions of an image without distorting it, or to cut away (mask) a 
portion of an image, do the following:

a. Click the image, then click the Crop image icon.

b. Click and drag the cropping handle until only the desired portion of the image remains.

16. Change Slide Layout. To add new slides with different layout options, from the New slide drop-down 
menu, select Title and Two Columns. 

17. Continue to add new slides (Slides 4-6) applying the slide layouts as indicated in 4.1 Figure A.

SLIDE 3

18. In the title box, type [Breakfast Power]. 

19. Create a Bulleted List. To create a bulleted list, click in the left column text box, then click the 
Bulleted list icon.
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20. Type the bulleted list shown in 4.1 Figure A and change the font size to 22. 

Note: Bullet points will automatically appear on the next line when you hit Enter.

21. Change Line Spacing. To increase the spacing between lines of text, select the bulleted list, then from 
the Line spacing drop-down menu, select 1.5.

22. Delete a Text Box. To remove a text box, place your cursor over any edge of the right column text 
box, click when a four-sided arrow appears, then hit the Delete key. 

23. Insert an image of a blueberry muffin, then position and resize it so that it is the approximate size and 
proportion as shown in 4.1 Figure A.

SLIDES 4-6

24. To complete SLIDES 4-6, using the content shown in 4.1 Figure A, repeat steps 19-23.

Hint: You will need to select an appropriate image that best illustrates the content of each slide.

25. Proofread your presentation for accuracy and format. 
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Formatting Text and ImagesLesson 4.1

26. Preview a Presentation. To view your presentation from the first slide, from the Present drop-down 
menu, select Present from beginning.

Hint: To advance from one slide to the next, click your mouse.

27. Exit a Presentation. To exit full screen mode, and return to regular viewing mode, hit the Esc key.

28. Share a Presentation. To share this presentation, click the Share button. 

29. Type the email address of the person you would like to share your presentation with, such as your 
instructor, assign them permission to edit the document, include a note informing the recipient that 
you have shared a presentation with them, then click Send. 

30. Notice that the Share button has changed to indicate your presentation has been shared. 
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31. Close a Presentation. To close your presentation, click the X on the Lesson 4.1 tab.

Note: Depending on the browser being used, your tabs may differ in appearance.

32. You should now see the Lesson 4.1 presentation in your My Slides folder. 
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Formatting Text and Images

Hearty Dinner
● Chicken Fajitas & Salsa

● Turkey & Spinach Lasagna

● Baked Salmon & Broccoli

● Baked Potato & Chili

● Veggie & Shrimp Stir Fry

● Broiled Chicken & Veggies

Smart Snacks
● Whole Wheat Pretzels

● Fresh Veggies & Hummus

● Low Fat Cheese Wrap

● Apple with Almond Butter

● Cream Cheese & Celery

● Fruit Kabobs and Yogurt

Lunch with a Punch
● Turkey Tortilla Wrap

● Egg or Tuna Salad Wrap

● Chicken Caesar Salad

● Salami, Olives & Cheese

● Veggie Pizza

● Whole Grain Bagel Pizza

Breakfast Power
● Peanut Butter Protein Bars

● Egg and Sausage Burritos

● Blueberry Muffins

● Fresh Fruit and Yogurt

● Green Monster Smoothie

● Sweet and Salty Trail Mix

Introduction

Juggling school work, after-school activities, and a 
social life with friends, it’s no wonder teenagers 

struggle to eat healthy foods. This presentation is a 
guide to help teens make healthy food choices.

Easy Eats for Teens
A Guide to Healthy Eating

Slide 6 Layout: Title and Two ColumnsSlide 5 Layout: Title and Two Columns

Slide 4 Layout: Title and Two ColumnsSlide 3 Layout: Title and Two Columns

Slide 2 Layout: Title and BodySlide 1 Layout: Title Slide

4.1 Figure A
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1. In your My Slides folder, create a new presentation, select the Dark Gradient theme, and name it 
Lesson 4.2.

SLIDE 1

2. In the title box, type [Fun With Apps]. In the subtitle box, type [Created by <your name>]. 

3. Add a Title Only slide.

SLIDE 2

4. In the title box, type [Weather App].

5. Insert Shapes. To insert ready-made shapes such as circles, squares, and arrows, do the following:

a. From the Shape drop-down menu, select Shapes, then select a Rounded Rectangle. 

Fun With Apps
Using Shapes

As part of your Mobile App Design class, you are required to first 
create icons for some of the most popular mobile apps. As you study 
the apps and their symbols, you realize they use basic shapes and 
colors that are easy for the user to identify. You decide to start by 
creating icons for apps related to the weather, maps, messaging, 
calendar, and calculator.

Overview

New Skills

Instructions

Insert Shapes • Align Shapes • Change Fill Color • Change Line Color 
• Change Line Weight • Duplicate a Slide • Use Undo/Redo • Insert 
Word Art • Insert a Text Box • Group Objects • Use Zoom

In this lesson, you will use 
drawing tools to create 
app icons commonly 
found on smartphones. 
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Lesson 4.2 Using Shapes

b. To create a rounded square, hold the Shift key down, click and drag until your square is similar in 
size and scale to the one shown in 4.2 Figure A.

6. Align Shapes. To align objects horizontally and vertically, click and drag your rounded square and use 
the red guide lines that appear to align it to the center of the slide.

7. Change Fill Color. To change the fill color of a shape, select your rounded square, then from the Fill 
color drop-down menu select cornflower blue.

8. Change Line Color. To change the line color of a shape, select your rounded square, then from the 
Line color drop-down menu select White.
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Lesson 4.2Using Shapes

9. Change Line Weight. To change the line weight of a shape, select your rounded square, then from 
the Line weight drop-down menu, select 8px.

10. Insert a Sun shape similar in size and scale to the one shown in 4.2 Figure A, then position it so that it 
is centered on top of the rounded square.

11. Change the fill color and line color of the sun to orange, and the line weight to 1px.

12. Duplicate a Slide. To make a copy of an existing slide, select the Slide 2 thumbnail, then from the 
Slide menu, select Duplicate slide. 

Alternatively, you can right-click on the slide 2 thumbnail and select Duplicate slide.
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Using Shapes

SLIDE 3

13. Change the word [Weather] to [Maps].

14. Change the fill color of the rounded square to red berry.

15. Use Undo. To undo the last action performed, click the Undo icon. 

16. Use Redo. To redo the last action undone, click the Redo icon.

Note: The rounded square should once again be red berry.

17. Delete the sun shape.

18. From the Shape drop-down menu, select Arrows, then insert a Bent arrow similar in size, scale, and 
position to the one shown in 4.2 Figure A.

19. Change the fill color and line color of the arrow to white.

20. Duplicate Slide 3.

SLIDE 4 

21. Change the word [Maps] to [Messages].

22. Change the fill color of the rounded square to dark green 2.

23. Delete the bent arrow.
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24. From the Shape drop-down menu, select Callouts, then insert an Oval Callout similar in size, scale, 
and position to the one shown in 4.2 Figure A.

25. Change the fill color and line color of the callout to white.

26. Duplicate Slide 4.

SLIDE 5

27. Change the word [Messages] to [Calendar].

28. Change the fill color of the rounded square to gray.

29. Delete the rounded callout shape

30. Insert Word Art. To insert Word art, from the Insert menu, select Word art. 

31. In the word art dialog box, type [30] and hit Enter. 

32. Resize the word art so that it is similar in size, scale, and position to the one shown in 4.2 Figure A, then 
change the fill color and line color to white.
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Using Shapes

33. Insert a Text Box. To insert a text box anywhere on your slide, do the following:

34.  Click the Text box icon.

35. Click and drag your cursor from the left side to the right side of your rounded square.

36. Type [SUNDAY] in the text box, bold, center align, change the font size to 30, then position as shown in 
4.2 Figure A.

37. Duplicate Slide 5.

SLIDE 6

38. Change the word [Calendar] to [Calculator].

39. Change the fill color of the rounded square to orange.

40. Delete the text box and word art.

41. From the Shape drop-down menu, select Equation, then insert the shapes Plus, Minus, Multiply, 
and Equal similar in size, scale, and position to the ones shown in 4.2 Figure A.

42. Change the fill color and line color of the equation shapes to white, and the line weight to 1px.
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43. Group Objects. To join objects together so that you can move or format them as a single object, click and 
drag over all of the elements of the calculator app drawing, then from the Arrange menu, select Group. 

Note: Notice that the calculator app drawing moves as a single object. 

44. Use Zoom. To increase or decrease the zoom setting, click the Zoom icon, then left-click to zoom in, 
and right-click to zoom out.

45. Proofread your presentation for accuracy and format. 

46. Preview your presentation from the beginning. Your presentation should look similar to 4.2 Figure A.

47. Share or print your presentation if required.
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Using Shapes

Calculator AppCalendar App

SUNDAY

Messages AppMaps App

Weather App

Fun With Apps
Created by <Your Name>

Slide 6 Layout: Title OnlySlide 5 Layout: Title Only

Slide 4 Layout: Title OnlySlide 3 Layout: Title Only

Slide 2 Layout: Title OnlySlide 1 Layout: Title Slide

4.2 Figure A
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1. In your My Slides folder, create a new presentation, select the Modern theme, and name it Lesson 4.3.

2. Insert five additional slides, applying the slide layouts as indicated in 4.3 Figure A. Use these slides as a 
guide when formatting each slide.

SLIDE 1

3. Type the title and subtitle. 

4. Use an Image as a Background. To insert an image as a slide background, do the following:

a. With nothing on your slide selected, click the Background button.

Traveling to Hawaii
Working with Images

You recently signed up to participate in the annual Geography Fair at 
school. Most students use posterboard backdrops as the main focal 
point of their presentation, so you decide to use your Google Slides 
skills to create a more interactive presentation. Community members 
have volunteered to judge the projects, and you really want to 
impress them with your knowledge of Hawaii, as well as with your 
Slides skills.

Overview

New Skills

Instructions

Use an Image as a Background • Use Color as a Background • Create 
a Numbered List • Use Image Options • Mask an Image • Reset an 
Image • Insert a Link • Vertically Align Text • Insert a Video • Apply 
Transitions • Delete a Slide • Automatically Advance Slides

In this lesson, you will use 
Google Slides to create 
a presentation about 
traveling to Hawaii.
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Working with Images

b. In the Background dialog box, click the Choose button. 

c. In the Insert background image dialog box, click Search, type [Hawaii] in the Google search 
field, then hit Enter.

d. Double-click an image of your choice, then hit Done.

5. Change the font color of the title and the subtitle to white.

SLIDE 2

6. Type the title.

7. Use Color as a Background. To apply a color to a slide background, do the following:

a. With nothing on your slide selected, click the Background button.

b. From the Background dialog box, click the Color drop-down menu and select cyan, then hit Done.
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8. Insert three images of popular Hawaiian tourist attractions, resize, then position as shown in 4.3 Figure A.

9. Insert a text box to label each image. Change the font color to white and the fill color to black, then 
position as shown in 4.3 Figure A.

SLIDE 3

10. Type the title and change the background color to cyan.

11. Create a Numbered List. To create a numbered list, click in the left column text box, then click the 
Numbered list icon.

12. Type the Numbered list shown in 4.3 Figure A. 

Hint: Numbers will automatically appear on the next line when you hit Enter.

13. Delete the right column text box and insert two Hawaiian culture-themed images. Resize and position 
as shown in 4.3 Figure A.

14. Use Image Options. To adjust the brightness and contrast of an image, do the following:

a. Select an image, then click the Image options button.

b. In the Image Options panel, Adjustments section, use the Brightness and Contrast sliders to 
enhance the look of your images, then click the X to close the Image Options panel. 
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Working with Images

SLIDE 4

15. Type the title and bulleted list, then change the background color to cyan.

16. Delete the text box on the right side of the slide, insert an image of a papaya, then resize and position 
as shown in 4.3 Figure A.

17. Mask an Image. To change the shape of an image, select the image, click the Mask image drop-down 
menu, select Shapes, then select the Oval shape.

Note: Your image should now be oval shaped.

18. Reset an Image. To reset an image to its original format, select the image, then click the Reset image 
icon.

19. Insert an image of a coconut, then resize and position as shown in 4.3 Figure A.

20. Mask each image with a rounded rectangle.

SLIDE 5

21. Type the title and change the background color to cyan.

22. Insert a Link. To insert a hyperlink for quick access to a web page, do the following:

a. Click in the text box on the left, then from the Insert menu, select Link.
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b. In the Link field, type [Hawaii tourism], then select Hawaii’s Official Tourism Site. 

c. In the Text field, type [Come Visit Us Soon!], then click Apply.

23. Vertically Align Text. To vertically center align text to the middle of a text box, select the text, then 
from the Align drop-down menu, select Middle. 

24. Delete the text box on the right.

25. Insert a Video. To add a video clip to a slide, do the following:

a. From the Insert menu, select Video.

b. In the YouTube search box, type [Hawaii tourism], then hit Enter. 
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c. Click the Play symbol to preview a video. 

d. Double-click the video link to insert it into your presentation, then resize and position as shown in  
4.3 Figure A.

26. Delete a Slide. To delete a slide from your presentation, click the Slide 6 thumbnail, then hit the Delete key.

Alternatively, you can select the Slide 6 thumbnail, right-click, and select Delete slide.

27. Apply Transitions. To add interest when advancing from one slide to the next, do the following:

a. Click the Slide 1 thumbnail, then click the Transition button.

b. In the Animations panel, Transition type drop-down menu, select Cube.

c. Using the Duration slider, adjust the speed of the transition to 1.5 seconds, then click the Apply 
to all slides button so transitions will be inserted between each slide.
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28. Automatically Advance Slides. To automatically move from one slide to the next (without clicking), 
from the Present drop-down menu, select Present from beginning, then click Play.

29. Proofread your presentation for accuracy and format. 

30. Your presentation should look similar to 4.3 Figure A.

31. Share or print your presentation if required.
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Tourist Information

Come Visit Us Soon!

Hawaiian Food
● Pineapple
● Papaya
● Coconut
● Baked Mahi Mahi
● Poi
● Teriyaki Beef
● Chicken Long Rice

Hawaiian Culture
1. Music
2. Dance
3. Legends
4. Language
5. Surfing
6. Nature

What to See

Luau Beach Volcano

Travel to Hawaii
Exploring the Pacific Islands

Slide 5 Layout: Title and Two Columns

Slide 4 Layout: Title and Two ColumnsSlide 3 Layout: Title and Two Columns

Slide 2 Layout: Title OnlySlide 1 Layout: Title Slide

4.3 Figure A

Slide 6 Layout: Title and Two Columns
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1. In order to complete this lesson, you must be assigned a partner with whom you will collaborate. Once 
partners have been assigned, determine who will take on the role of Student A and who will take on 
the role of Student B. 

2. Before you begin, carefully review all of the instructions in this lesson.

3. STUDENT A will be responsible for editing slides 1-3, and STUDENT B will be responsible for editing slides 4-6.

4. STUDENT A: In your My Slides folder, create a new presentation, select the Biz theme, and name it 
Lesson 4.4.

5. STUDENT A: Share the presentation with STUDENT B. Assign them permission to edit and be sure to 
include a note informing STUDENT B that you have shared a document with them.

6. STUDENT A: Add five additional Title only slides.

7. STUDENT B: In your Shared with Me drive, open Lesson 4.4.

8. Collaborate. When more than one person is simultaneously editing a slide, each person’s Insertion 
Point is a different color. A colored box will also appear at the top of the screen.

Safe Cars for Teens
Collaborating with Slides

Choosing a safe and affordable car is important, and doing research 
helps teens and parents make good decisions. The Insurance 
Institute for Highway Safety is a resourceful web site that provides 
data related to safe cars. In this collaborative project, you and a 
partner will create a presentation that provides information about 
affordable cars that are safest for teen drivers.

Overview

New Skills

Instructions

Collaborate • Insert a Table • Copy and Paste • Insert an Animation

In this lesson, you and a 
partner will collaborate 
by editing a shared 
presentation.  
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SLIDE 1 (STUDENT A)

9. Type the title and subtitle, change the font size of the title to 60, then add an image similar to the one 
shown in 4.4 Figure A.

SLIDE 2 (STUDENT A)

10. Type the title.

11. Insert a Table. To insert a table to organize information with columns and rows, from the Table menu, 
select Insert table with 3 columns and 6 rows.

12. Copy and Paste. To copy text or an object and duplicate it in another position in your presentation, 
do the following:

13. Select your table, place your cursor over the thick blue border, right-click when it becomes a four-
sided arrow, then select Copy.

Collaborating with Slides
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14. Click on the Slide 3 thumbnail, right-click, select Paste, then return to Slide 2.

15. Type the text into the table exactly as shown on 4.4 Figure A. 

16. Bold the text in row 1 and change the font size of the entire table to 20. 

17. Insert an Animation: To make a presentation more interesting by animating text or objects, do the 
following:

a. Click on the table to select it.

b. From the Insert menu, select Animation. 
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c. From the Animations panel, Animation type drop-down menu, select Fly in from left.  

d. From the Start condition drop-down menu shown below, select With previous. 

e. Click Play (shown below) to preview the animation. 

f. Click the X (shown below) to close the animation menu. 

SLIDE 3 (STUDENT A)

18. To complete Slide 3, using the content shown in 4.4 Figure A, type the title and repeat steps 15-17.
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SLIDE 4 (STUDENT B)

Important Note: As you create slides 4-6, carefully review instructions 10-17 for visual reference.

19. Type the title.

20. Insert a Table. To insert a table to organize information with columns and rows, from the Table menu, 
select Insert table with 3 columns and 6 rows.

21. Copy and Paste. To copy text or an object and duplicate it in another position in your presentation, 
do the following:

a. Select your table, place your cursor over the thick blue border, right-click when it becomes a four-
sided arrow, then select Copy.

b. Click on the slide 5 thumbnail, right-click, select Paste, then return to slide 4.

22. Type the text into the table exactly as shown on 4.4 Figure A. 

23. Bold the text in row 1 and change the font size of the table to 20. 

24. Insert an Animation: To make a presentation more interesting by animating text or objects, do the 
following:

a. Click on the table to select it.

b. From the Insert menu, select Animation. 

c. From the Animations panel, Animation type drop-down menu, select Fly in from right.  

d. From the Start condition drop-down menu, select With previous. 

e. Click Play to preview the animation. 

f. Click the X to close the animation menu. 

SLIDE 5 (STUDENT B)

25. To complete Slide 5, using the content shown in 4.4 Figure A, type the title and repeat steps 22-24.

SLIDE 6 (STUDENT B)

26. Type the title and add an image similar to the one shown in 4.4 Figure A.

27. STUDENTS A and B: When both partners have completed the slides, view your presentation from the 
beginning.

28. Proofread your presentation for accuracy and format. Your presentation should look similar to 4.4 
Figure A.

29. Share or print your presentation if required.
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Whatever You’re Driving, Be Safe!Large Cars Under $10,000

Car Model Years Price

Acura RL 2005 and later $9,700

Mercury Sable 2009 $9,700

Kia Amanti 2009 $9,500

Ford Taurus 2009 $9,100

Audi A6 2005 and later $8,300

Midsize Cars Under $10,000

Car Model Years Price

Subaru Legacy 2009 $9,900

BMW 3-series 2006 and later $9,300

Mazda 6 2009 and later $8,900

Saturn Aura 2009 $8,800

Acura TL 2004 and later $7,900

Large Cars Under $20,000

Car Model Years Price

Saab 9-5 2010 and later $17,500

Lincoln MKS 2009 and later $15,500

Buick Regal 2011 and later $13,500

Ford Taurus 2010 and later $13,500

Buick LaCrosse 2010 and later $12,900

Midsize Cars Under $20,000

Car Model Years Price

Toyota Prius v 2012 and later $19,100

Mercedes-Benz C-
Class

2009 and later $16,000

Honda Accord 2012 and later $14,400

Audi A4 2009 and later $14,300

Toyota Camry 2012 and later $14,300

Safe Cars for Teens
Created by <Student A and Student B>

Slide 6 Layout: Title OnlySlide 5 Layout: Title Only

Slide 4 Layout: Title OnlySlide 3 Layout: Title Only

Slide 2 Layout: Title OnlySlide 1 Layout: Title Slide

4.4 Figure A


